
Using Flash CS6  1 - Introduction 

© Steve O’Neil 2012 Page 1 of 21 http://www.oneil.com.au/pc/ 

 

Using Flash 

Contents 
Using Flash ........................................................................................................................................................ 1 

Overview ....................................................................................................................................................... 2 

About Flash ............................................................................................................................................... 2 

Key Concepts ............................................................................................................................................. 2 

Frames ....................................................................................................................................................... 2 

Key Frames and Tweening ........................................................................................................................ 2 

Meet Flash ..................................................................................................................................................... 3 

Menu Bar ................................................................................................................................................... 3 

Tools Panel ................................................................................................................................................ 3 

Control Panel ............................................................................................................................................. 3 

Panels ......................................................................................................................................................... 4 

Timeline ..................................................................................................................................................... 4 

File Tabs .................................................................................................................................................... 4 

The Stage ................................................................................................................................................... 4 

Exercise 1. Starting a Flash Project .......................................................................................................... 5 

Exercise 2. Customising the Workspace .................................................................................................. 6 

Exercise 3. Using the Shape Tools ........................................................................................................... 7 

Exercise 4. Selecting Shape Colours ........................................................................................................ 8 

Exercise 5. Drawing other shapes ............................................................................................................ 9 

Exercise 6. Selecting Shapes .................................................................................................................. 10 

Exercise 7. Additional methods for selecting shapes ............................................................................. 11 

Exercise 8. Cookie Cutter shapes ........................................................................................................... 12 

Exercise 9. Changing shape settings ...................................................................................................... 14 

Exercise 10. Using the pencil tool ............................................................................................................ 15 

Exercise 11. Using the Brush Tool ........................................................................................................... 17 

Exercise 12. Using the Pen Tool .............................................................................................................. 18 

Exercise 13. Modifying Anchor Points .................................................................................................... 19 

Exercise 14. Pen Practice ......................................................................................................................... 20 

Exercise 15. Shape Practice...................................................................................................................... 21 

 



Using Flash CS6  1 - Introduction 

© Steve O’Neil 2012 Page 2 of 21 http://www.oneil.com.au/pc/ 

Overview 

About Flash 

Adobe Flash is an application that is used to create various types of animation. It is commonly used on the 

Internet due to the small file sizes possible with Flash and many of its features are specially tailored for use 

in websites. Flash was originally an animation application called FutureSplash Animator until it was 

bought by Macromedia in the mid 90s and renamed Flash. In recent years the company Macromedia was 

acquired by Adobe Systems and is now sold as Adobe Flash. These tutorials have been prepared using 

Adobe Flash  CS6 Professional which is the 12th version of Flash. You can check which version you are 

using by going to the Help menu and then choosing the About option at the bottom of the menu. Most of 

what we will do in these exercises will be the same or similar in older or newer versions of Flash. 

Key Concepts 

Before we learn about Flash it is important to understand some concepts that are important in all forms of 

animation. Flash uses some terminology that is common, not only in computer animation but in traditional 

forms of animation also. 

Frames 

When you watch a film the movie is made up of frames being displayed 

quickly one after another. The amount of frames that appear each second can 

vary. For example Australian analogue television is based on the PAL standard, 

which shows 25 frames per second. 

In Flash you can modify the number of frames which appears each second, 

though 24 frames per second is the default setting. 

Key Frames and Tweening 

In traditional animation, such as old Disney cartoons, each frame was drawn by hand. The main animator 

didn’t necessarily draw each and every frame though. Generally the lead artist or animator would draw 

frames which showed the main sequence, such as a frame for each second. Then those frames would be 

passed on to an assistant animator who would draw the frames in between. The frames drawn by the lead 

animator are the key frames while the process of connecting them with intermediate frames in tweening. 

The same concept applies in computer animation. Rather than have to draw every single frame of animation, 

you will typically only crate key frames at important points in your animation. Then you can use tweening to 

get the computer to fill in the frames in between. The following example shows how tweening creates frames 

that lead to a smooth transition between key frames. 
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Meet Flash 

Like most applications, Flash can be opened in a variety of ways, such as 

selecting the link from the Windows Start Menu.  

When Flash is open, it will look similar to the following example. 

Menu Bar 

Along the top of the window is the Menu Bar. This 

works like the menu in most Windows applications and 

we will use it frequently to access important functions in Flash.  

Tools Panel 

 
The Tools Panel sits along the right side of the window (unless you decide to move it) and provides 

access to tools used for drawing and similar functions. In older versions of flash it generally appeared 

on the left side.  

 

Control Panel 

Along the side of the window is the Properties Panel. The options in 

this panel will change depending on what tool or object you have 

currently selected. A tab along the top allows you to change to the 

Library Panel. 
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Panels 

To the left of the Properties panel you may see 

various other panels. Many of them will be hidden 

but can be displayed by clicking on one of the 

panel icons. 

Many of the panels can be arranged in different 

ways on your screen. If at any time you would like 

to return the position of the Flash Panels to their 

original position, you can go to the Window menu 

and select Workspace and then select one of the default layouts such as Essentials.  

 

Timeline 

Along the bottom of the screen will be the Timeline 

area (along the top in older versions). The left section of 

this area will contain the layers that are being used in 

your animation. The right section of this area contains 

the timeline which allows you to control the frames in 

your animation.  

File Tabs 

Along the top of the screen beneath the menus, you will see a tab for each file you have open. These can be 

used to easily close or switch between open files. 

 

The Stage 

The main editing area of Flash is referred to as The Stage. This is where all the action takes place, just like 

the action in a play takes place on the stage. 
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Exercise 1.  Starting a Flash Project  

When you first open Flash or when you close all the files you have been working on, you will usually see a 

Welcome Screen like the one below taking up the timeline and stage area.  

 
 
The left part of the welcome screen lists common template categories and also lists the most recently opened 

files. There are templates for a wide variety of uses such as creating flash animations for banners on websites 

or for use on mobile phones. If this is the first time you have used Flash the recent files list will be empty. 

You can quickly open a file by clicking its name in this list. You can also open recent files from the File 

menu. 

The central part of the welcome screen provides options for creating a new Flash file. 

The right section provides a list of tutorials to help with learning specific areas of flash.  

1. Select Create New, ActionScript 3.0 options from the central section of the welcome screen. If 

the welcome screen is not showing, Select New from the File menu and then select the 

ActionScript 3 option from the General tab. You will now have a new flash file with an empty 

stage before you. 

Note Action script is a language which allows you to add more advanced elements and 

interactivity to your animations. Flash CS6 allows you to create Flash projects that use either 

version 2 or 3 of the language. For most of the early projects we will be working on it won’t 

matter whether you select version 2 or 3, but generally we will select version 3. 
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Exercise 2.  Customising the Workspace 

Flash includes several default work layouts you can choose from. You can also customise any one of these 

layouts to suit the way you prefer to work. A menu for selecting the pre-set customisations is available at the 

top of your screen. 

 

1. Click the menu option shown to display a list of the pre-set 

workspace layouts. These selections are also available from 

going to the Window menu and selecting Workspace. 

2. Select Classic from the list. This will arrange the interface to 

resemble the workspace that was the default in older versions of 

flash. 

3. Select a couple of different layouts to view the different ways 

your workspace can be arranged. 

4. Select Essentials to return to the default Essentials workspace. 

5. Move your mouse over the line that divides the Tools from the 

Preferences Panel. 

 

6. Drag to the left or right to change the width of the Tools Panel until the icons show in two 

columns (on smaller monitors this might be necessary in order to view all of the icons). 

7. Drag the line to the left of the Preferences Panel to make it wider. 

8. Click the Collapse to Icons button in the top corner of the 

Properties Panel. 

9. Click the same button (now an Expand to Panels button) to 

return the properties panel to its full size. 

10. Move your mouse over the tab at the top of the Properties 

Panel. 

 

 

11. Drag that tab to move the entire panel. 

12. From the Workspaces list select Reset ‘Essentials’ to return to the default layout. 

Note You can customise the workspace any way you wish but the remainder of the exercises will 

generally assume you are using the Essentials workspace. 
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Exercise 3.  Using the Shape Tools  

Flash has several shape tools that you can use to help you create pictures for your animations. 

1. Locate the Shape tool to the left of the screen on the Tools Panel. Depending on which shape 

was last used the picture on the icon may look like an ellipse or a rectangle shape.  

2. You will notice a small triangle shape in the bottom corner of 

the icon. This lets you know that there is more than one tool 

grouped together. Click on the icon and hold your mouse 

button down to see the rest of the icons in the group.  

3. Click on the Rectangle Tool icon to select it. 

Tip – you will notice that the icon has a letter R next to it. That lets you know that in future you can 

select the rectangle tool by pressing R on your keyboard. Paying attention to the tips given 

on the icons, or the tool tips as you move your mouse over an icon, is a good way of 

learning shortcuts. 

4. You can draw shapes in either Merge drawing mode or Object drawing mode. This is determined 

by an Object Drawing icon  that appears near the bottom of the Tools Panel when you have a 

shape tool selected. Make sure that icon is turned off to begin with. 

Now you will have the rectangle tool activated and when you move your mouse over the stage, your 

mouse pointer will change in to a cross shape.   

5. With the rectangle tool still active, drag your mouse to create a rectangle shape in the top left 

section of the stage. A rectangle using the selected colours will be created. Unless you have 

changed the colours before drawing the shape, the rectangle will have a black outline and a 

white interior. 
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Exercise 4.  Selecting Shape Colours 

You can modify the colours of a shape either before you draw the shape, or after you have drawn it. 

In this exercise we will select colours and some other options before drawing a new shape. 

1. Make sure your Rectangle Tool is still selected. 

At the bottom of your Tools Panel there are 2 colour icons. One is for changing the Stroke colour. In 

most graphics program, the outline of a shape is referred to as the stroke. The other is for changing the 

Fill colour which is the colour inside the shape.  

2. Click the Stroke color icon (it looks like a pencil with a 

coloured square under it). A range of colours will 

appear. Later on we will look at advanced options for 

selecting colours but for now, click on any dark colour. 

This colour will be used for any shapes you draw from 

now until you select a different stroke colour.  

3. Click the Fill color icon (it looks like a paint can with a 

coloured square under it). A range of colours will 

appear. Click on any light colour. This colour will be 

used for any shapes you draw from now until you select a different fill colour. 

4. Now draw a new rectangle next to your first one and it will use the fill and stroke colours you 

have just selected. 

 

Tip If you want an even greater range of colours, click the  icon in the top right corner of the 

colour selector to open the colour mixer. 
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Exercise 5.  Drawing other shapes 

1. Change the fill colour and stroke colour the same way you did in the last exercise to colours of 

your own choosing. 

2. Click and hold your mouse button on the rectangle tool to see the other shape tools. 

3. Select the Oval Tool (you can also press the letter O on your keyboard to select the tool). 

4. Draw an oval near your rectangles. 

 

5. Hold your mouse on the shape tool and select the PolyStar tool.  

6. Choose a different Fill and Stroke colour for the new shape. 

Before you draw an object with this shape you can change the options to select how many sides the shape 

have. You can also choose to make the shape a star and modify how ‘pointy’ the star’s points will be. 

7. Make sure the Properties panel Is visible along the bottom of your window. You can select it 

from the Window menu or press Ctrl F3 on your keyboard if it isn’t. 

The options in the Properties Panel will change depending on what tool you are using. If you still have the 

PolyStar tool selected, the Properties panel will show  

at the top of the options. 

8. Click the  button to open the PolyStar options.  

9. Change the type of shape from Polygon to Star. 

10. Change the number of sides and star point size to an amount 

different from what was already selected and click OK. 

Note: When you draw a rectangle or oval you begin drawing from the corner. When you draw a 

polygon or star though, you draw from the centre of the shape outward. Keep this in mind 

when you choose where to draw it. 

11. Now that you have chosen your settings, draw the star shape near your other shapes. 
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Exercise 6.  Selecting Shapes 

If you want to modify shapes you have already placed on your stage, such as changing colours or 

moving them, you first need to know how to select shapes. Selecting objects in Flash has many 

things in common with other applications you may have learned, though there are a couple of 

techniques unique to Flash. 

Firstly, it is important to note that in Flash, a shape is made up of the Fill and the Stroke. These are 

often treated as separate components even though they may look like they are all part of the same 

object. This allows you to select parts of a shape separately but it also means that you need to know 

how to select the whole shape when necessary. 

1. Choose the selection tool from the top of your Tool Panel by clicking the icon  or pressing V 

on your keyboard. Move your mouse over the middle of one of your rectangles. 

2. Move your mouse over the middle of the first rectangle you drew. While 

your mouse pointer is over the middle of a shape your mouse pointer 

will change from the normal selection arrow to a different shape.  

3. Click the rectangle to select it. The inside of the rectangle will become shaded to show that it is 

selected. 

4. Drag the rectangle away from the other shapes. 
You will notice that the fill of the rectangle (the interior) will move but the 

stroke (the line around the rectangle) stays behind. This is because when you 

click in the middle of the shape you have only selected the Fill and not the Stroke. 

5. Go to your Edit menu and select Undo or press Ctrl Z on your keyboard to undo the move. 

6. Click on a blank area of your stage or press the Esc key to make sure no shape is selected. 

7. Move your mouse over the stroke (outline) of the first rectangle you 

drew. Your mouse pointer will change in to a different shape. The exact 

shape will depend on whether your mouse is over one of the sides or one 

of the corners as the following examples show.   

8. Click to select one of the sides of the rectangle. That line will be shaded to show it is selected. 

Note: When you are selecting colours for either a Fill or a Stroke, in the top corner of the colours 

you can see a No colour icon . If you select this icon then the shape you draw will have no 

fill or no stroke, depending on which one you were changing at the time. If a shape has no 

stroke then you won’t be able to click on its edge. If a shape has no fill then you won’t be 

able to click in the middle to select it. 

9. Move your mouse over the fill (middle) of the rectangle and double-

click. This will select the whole shape including both the Fill and Stroke. 

10. Try selecting one of your other shapes in the same way. 

Note If you have the Object Drawing icon  turned on when you draw a shape, the fill and stroke 

will be treated as one object when you select the. You won’t be able to edit them separately 

as we are about to but you will be able to change their colours separately. 
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Exercise 7.  Addit ional methods for selecting shapes  

One additional way that you can select a shape is by dragging your mouse around the shape you 

want to select. 

1. Make sure you have the select tool active and move your mouse to an area above and to the 

right of the second rectangle you drew. 

Tip: If you have another tool active, you can temporarily activate the 

Select tool at any time by holding down the Ctrl key. This will 

allow you to use the Select too for selecting or moving shapes, 

without abandoning whatever tool you were already using. 

2. Hold down your mouse button and drag a rectangle shape that completely surrounds the shape.  

If you don’t drag your mouse around the entire shape then only the parts you drag your mouse around will be 

selected. 

3.  Drag your mouse around the oval shape, but this time, don’t select 

the entire shape. Now try dragging the selected area away from the 

rest of the shape. The selected area will become separated from the 

rest of the shape. This can be very handy as an easy way of splitting 

a shape in to separate pieces but be careful, people sometimes do 

this accidentally when they were trying to select the whole shape. 

You can also select more than one shape in a 

variety of ways. 

4. Drag a rectangle area with your 

selection tool that covers both of your 

rectangles so that they both become 

completely selected. 

You can also use your shift key to select and de-select objects. 

5. Hold down shift and click on an object (such as your star) to add it to what is 

currently selected. Remember that when you do this you will only select the part 

you click such as the fill or a part of the stroke. You will need to hold down 

shift and click on the other parts of the shape if you want them to be selected also. 

In the example shown to the right, the fill of the star is selected but only some parts 

of the stroke along the right edge are selected. 

6. Hold down shift and click on an object that is already selected to de-select it. 

7. Press Ctrl A to select everything on your stage. 

8. Press Esc to ensure nothing is selected. 

9. Save your file with the filename Basic Shapes (Crtl S or choose the Save option from the File 

menu). 

10. Close the file (Crtl W or choose the Close option from the File menu). 
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Exercise 8.  Cookie Cutter shapes 

Many people are familiar with using a cutter to cut out shapes from pastry. A 

similar concept can be used to create shapes in Flash. This is because 

when a shape in flash is moved to overlap another shape, it will remove 

the parts of the other shape that it covers. The exercise below will illustrate 

how this can be used. 

1. Create a new blank Flash File from the welcome screen or from the file 

menu. 

 

2. Select the Oval tool.  

3. Set the Fill colour to yellow and set the Stroke color to the same colour. 

4. Draw a circle on your stage. When you are drawing the shape, when the width and 

height are similar, you can see a small circle next to your mouse. This lets you 

know that Flash is helping you to keep the height and width the same so that your 

oval will be a perfect circle. You can also hold down the Shift key when you are drawing any 

shape to ensure that the height and width stay the same. 

5. Draw a smaller circle next to the first one. 

 

6. Now using the Select tool , select the smaller circle. Make sure you select the whole circle and 

not just the fill (hint – double click with the selection tool to select the entire circle). 

7. Drag the smaller circle so that it overlaps the larger circle. 

Tip: In addition to dragging objects with your mouse, you can also move them a little bit at a 

time by pressing the arrow keys on your keyboard. This is good for small adjustments. 
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8. Press Esc so that nothing is selected. 

9. Double click the smaller circle again to select it. 

10. Drag it away from the larger circle. The parts of the larger circle that were covered have now 

been removed, leaving us with a neat, crescent moon shape. You can use this technique to create 

a wide variety of shapes with the ‘cookie cutter’ method. 

 

Note: In later exercises we will begin to use Layers so that we can make shapes overlap without 

them affecting each other in the way we have just seen. You can also create shapes with the 

Object Drawing option active if you want to be able to move them around without removing 

parts of other shapes. 

11. Save the file as Moon and close the file. 
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Exercise 9.  Changing shape sett ings  

1. Open your Basic Shapes file. 

2. Select your star shape using any of the methods learned previously. (make sure you have the 

whole shape selected including stroke and fill). 

The Properties Panel will show the properties for the selected shape. 

The first options can be used to change the Width and Height of the 

shape (later we will look at using the transform tool to resize objects). 

3. Use the Stroke colour option to change the line colour. 

 

4. Use the Fill colour option to choose a different colour for the 

fill.  

5. Use the Line thickness option to change the line thickness to 

5.  

6. Use the Line style option to select a dashed line. 

 

7. Save the changes to the document. 
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Exercise 10.  Using the pencil  tool  

1. Create a new blank Flash file. 

2. Select the Pencil tool.  

Look at the Properties Panel and you might notice that the options for the pencil tool are the same as the 

last stroke options you used. In this case they will most likely be the same as the settings you changed for the 

stroke around your star in the last exercise. 

3. Change the stroke options as shown below. 

 

4. Use the pencil tool to draw a small fish on your stage. Make sure there are no gaps in the outline 

of your fish (If it turns out as a square shape you might have to do step 8 and 9 first). 

 

As long as you left no gaps around the edge of the shape you drew, you will now be able to apply a fill to the 

shape you have drawn. 

5. Select the Fill tool.  

6. Select a light fill colour from the Fill colour selector.  

7.  Click inside the fish to apply the fill colour. 

 

Note The fill tool won’t work if there are gaps around the edge of the shape you have drawn. 
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In addition to being able to change the stroke options for the pencil tool, you can also change the pencil 

mode options. 

8. Select your Pencil tool and then locate the Pencil Mode icon  at the bottom of the toolbar. If 

you can’t see it because you are using a small screen size, you may need to widen the toolbar to 

show the icons in two columns. 

Each of the pencil modes determines how your pencil follows your mouse movements as demonstrated 

below. 

   

   
Straightens the lines as you draw 

them with the pencil 

Smoothes the lines as you draw with 

the pencil 

Follows your mouse movements 

exactly, without smoothing or 

straightening the lines 

9. Make sure the Smooth option is selected for pencil mode. 

10. Use the pencil to write your name, leaving plenty of room underneath. 

11. Now try writing your name again in the available space using both the straighten, and the ink 

pencil modes. 

 

12. Close the file (saving optional) 
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Exercise 11.  Using the Brush Tool  

1. Create a new blank flash file. 

The way the brush tool works is quite different to the pencil tool. When you use the Brush tool, there are no 

stroke options in the properties pane like there is with the pencil. Instead, there are options on the toolbar for 

selecting how thick your brush will be. The colours are selected using the usual fill and stroke options. One 

big difference is that when you draw with the Brush tool, the lines you draw will use your fill colour instead 

of the stroke colour. 

2. Select the Brush tool from the toolbar (or press the letter [B]).  

Look at the options at the bottom of the toolbar. You may need to show buttons in 2 columns to be 

able to see all of them if they don’t fit on your screen. Note that depending on the options selected, 

some of the icons may look the same so move your mouse over them until you see your tool tip to 

make sure you’re selecting the right one. 

3. Hold your mouse on the Brush Size icon  and select the last option (the largest brush size). 

4. Hold your mouse on the Brush Shape icon  (when the first option is selected it might look the 

same as the brush size icon) and select the second option.  

Note If you are using a graphics tablet with a pen like the one pictured to 

the right, you may also have icons that turn on additional options 

. These options can vary your brush strokes based on how hard 

you press with the pen and what angle you hold the pen. 

 

5. Select a dark fill colour and then draw the same fish that you drew in the previous exercise. 

You will notice that the brush shape means that the lines are thinner in some parts depending on 

which direction your mouse was moving. Sometimes it is easier to draw freehand with the brush 

tool than it is with the pencil tool, especially if you are using a graphics tablet. 
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Exercise 12.  Using the Pen Tool  

The pen tool is used for drawing straight lines and curves rather than freehand shapes. It can be a little 

confusing if you’re not familiar with it but once you’ve made a few shapes with it you should be more 

comfortable with it. The pen tool works by creating Line Segments which are joined up with Anchor 

Points. The line segments can be either straight or curved and are controlled by the anchor points using 

Direction Points. 

The following example shows straight and curved lines created using the pen tool 

 
 

 

 

We’ll start by using the pen to make a shape with straight line segments 

6. Create a new document and select the pen tool.  The stroke colour you used with the pencil 

tool will most likely still selected. If not then select a dark stroke colour. 

7. Click in the top left area of your stage to add an anchor point. 

8. Click to the right to make another anchor point. 

9. Move your mouse below the first two anchor points and click to add a third one. 

10. Move your mouse over the first anchor point you created. When you see a small circle appear 

you will know you’re back to your starting point. 

11. Double-click on your starting point to end placing anchor points and close the shape. If you only 

single click, then the next time you add an anchor point to start a new shape, Flash 

might assume you are continuing the current shape and join them together. Double-

clicking indicates that you are done.  

12. Select the fill tool, along with a suitable fill colour and then click in the 

closed shape to fill it. Note that this will only work if you close the shape by 

placing the last anchor point on the starting anchor point. 

Now we’ll try using the pen tool to create curved line segments 

Note Many vector image editing applications such as Adobe Illustrator also have a pen tool or 

something similar. 

Line segment 

Anchor point Curved Anchor point 

Direction point 
(controls the direction and 

sharpness of the curve) 
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13. Select the Pen tool 

14. Move your mouse to a blank area on your stage, making sure you have plenty of room to the 

right of where you click. 

15. Click and drag to the right, then release your mouse. As you are dragging, direction points will 

come out of the anchor point. The longer you drag, the more gradual the curve will be. The 

direction of the direction points controls the angle of the curve. The following examples show 

how the direction points can shape curves. 

 

16. Move your mouse upwards and to the right, then click and drag to create another curved anchor 

point. 

17. Move your mouse downward and to the right, then double-click. Hold your mouse on the 

second click and then drag to create your third curved anchor point. Because you double clicked 

the line will now be finished when you release your mouse. Your curved line should look 

similar to the example below. The direction and sharpness of your curve will depend on how 

you dragged your mouse. 

18. Create another wavy line to practice using the tool. 

 

Exercise 13.  Modifying Anchor Points  

19. Click the Subselection tool (the white arrow).  

20. Click on one of your non-curved anchor points on the triangle and drag it to modify its position. 

 

21. Click on one of the curved anchor points. Not only can you move the anchor point but you can 

also modify the direction points. Drag the direction points to see how it modifies the curve. 
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Exercise 14.  Pen Practice 

1. In a new Flash document, try creating the following shape using the Pen tool and the use the fill 

tool to fill the shape afterward. The second example shows a hint on what types of anchor points 

to add. The anchor points on the top edges are both curved anchors points while the ones in the 

middle are non curved. 

2. Choose a suitable stoke colour and thickness before you draw the shape. 

 

 
3. Save the new document as Heart. 
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Exercise 15.  Shape Practice 

1. Try to create the following image using the tools you have learned. 

 

 

 

Tip You can change the background colour of your stage by making sure nothing on the stage is 

selected so your document properties are showing in the Properties Panel. Then you can 

select a colour using the Stage colour option.  

2. Save the file as Train. 


